Simple Interface for Reconfigurable Computing (SIRC): Ethernet PC ↔ Xilinx V5 Communication

Ken Eguro 5/16/10 version 1.0.1

1. Introduction
The goal of the Simple Interface for Reconfigurable Computing (SIRC) project is to provide a fast and easy to use communication/control mechanism between C++ code running on a host PC and a hardware-based accelerator implemented on a FPGA. Our motivation is that the simple software and hardware interfaces of this API will lower the barrier to entry for reconfigurable hardware accelerators and attract new application developers. This system provides a complete and customizable interface solution that only requires users to have a basic knowledge of C++ and Verilog – only enough to develop their application-specific software and hardware computation. No in-depth knowledge of drivers, operating systems or communication protocols is necessary. Furthermore, the need for debugging is limited to users’ computational cores.

This version of the system provides communication via a 1 Gb Ethernet link between a Windows machine and a Xilinx Virtex 5 FPGA. In our testing, it achieves at least 50% of the maximum theoretical bandwidth with transfers of 8KB or larger and 95% with transfers of 128KB or larger.

Future releases will add the capability to use different communication methods (such as PCI Express, which is currently in the final stages of debugging), different operating systems and different FPGAs. Any updates will maintain the same software and hardware user interfaces. This will allow applications to easily migrate to new reconfigurable platforms with no changes to user code.

For the latest update, please visit the SIRC discussion forum at:


2. Setup & Installation

System Requirements
1) A network card capable of operating at 1 Gb. This can either be:
   a. a dedicated card that can be connected directly to the FPGA via a crossover cable. This is the preferred method and will provide the best performance.
   b. a card that shares a connection with normal PC network traffic and is connected to the FPGA and the upstream network link through a gigabit-capable switch.

2) A host PC with that meets the necessary requirements for Virtual PC 2007 (Note that Virtual PC itself is not actually used. This project only uses the Virtual Machine Network Services driver, but this is no longer available as a stand-alone download).
3) For direct use with the default settings, a Digilent XUPV5, a Xilinx ML505/ML507 board, or a BEE3 (either LX110T, LX155T or SX95T).

4) Xilinx ISE and a JTAG programming cable to create/compile user hardware-side applications and program the FPGA board (tested with both ISE 10.1 and 11.4).

5) Visual Studio to create/compile user software-side applications (tested with VS2005 and VS2008).

Host PC Installation Notes
Virtual PC 2007 SP1 is freely available for download from:


After installation on the host PC, verify that the Virtual Machine Network Services driver was installed properly and enabled only for the network card connected to the FPGA. This can be done by opening “Control Panel->Network Connections” and right-clicking to select “Properties” on each network connection on the host PC. While this window is open, if the FPGA is connected to a dedicated network card, it is also best to unselect all other services for this connection. Lastly, although unlikely if the correct connections (and network switches) are used, it may also be necessary to configure the network card connected to the FPGA to explicitly operate at a speed of 1 Gbps. The method of setting this value differs among card manufacturers and drivers, but it is typically accessed from the “Properties->Configure->Advanced” window of the network connection.

At this point, the user can verify the proper setup and connectivity between the host PC and FPGA if they have a Digilent XUPV5/ML505/ML605/ML507 or BEE3. We have included pre-compiled binaries for both the software and hardware portions of a simple example application in the “precompiledExampleBinaries” directory. These pre-compiled binaries can be used to follow the testing outlined in the “Programming & Execution of Example Program” section.

One note regarding Windows 7 – The existing SIRC software API only works with the network driver included with Virtual PC 2007 SP1. The new Virtual PC that accompanies XP Compatibility Mode (also a free download) uses a different network driver. If you see a “Virtual PC Network Filter Driver” option in your network card “Properties”, you should un-install XP Compatibility Mode (through “Control Panel -> Programs ->Uninstall a Program”) and install Virtual PC 2007 SP1. This compatibility issue will be resolved in future releases.

3. Software Interface
This goal of the following two sections is to provide a high-level view of the software and hardware-side APIs. This will enable users to understand the simple example application provided in “SW_Example” and “HWSrc” directories and build their own applications.

This API is intended to be used for batched execution on the FPGA in a master/slave style mode. The expectation is that the user’s program will:

1) send one or more pieces of data from the host PC to an input buffer connected to their circuit on the FPGA

2) signal the FPGA to start execution on that data

3) wait until the computation is done

4) retrieve the results from an output buffer also connected to the FPGA-based logic
All operations are initiated by the PC in a single threaded manner. Only one operation is performed at a time e.g. overlapped read and writes operations are not supported. Overlapped I/O can be supported by double buffering with multiple software and hardware APIs. A streaming interface will be introduced in future releases.

Although the API has the capability to configure the FPGA once both the software API on the PC and the hardware API controller on the FPGA are in communication with each other, it is expected that the hardware controller will be automatically bootstrapped onto the FPGA initially. As described in the “Programming FPGA & Execution of Example” section, this is typically performed either with IMPACT through a JTAG programmer or (preferably) via power-on initialization from flash memory.

As will be described in more detail in the “Hardware Interface” section, the user’s circuit on the FPGA will communicate with the host PC through the hardware-side communication API. This hardware API has five primary features: an input memory, an output memory, a 255 x 32-bit parameter register file, a userRun signal, and a userSideReset signal. The userRun signal tells the user’s circuit to begin execution. This signal is also used to indicate when the user’s circuit has completed execution. The userSideReset signal tells the user’s circuit that it should reset. These five parts of the hardware-side API are controlled in software via member functions of the ETH_FPGA class. The twelve functions within the ETH_FPGA class define the software-side API:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>constructor</strong>&lt;br&gt;<code>ETH_FPGA(uint8_t *FPGA_ID)</code></td>
<td>Constructor for the API class. <code>FPGA_ID</code> is an array of 6 bytes that contain the MAC address of the target FPGA. This function only initializes the software side of the system. The FPGA is not programmed, but it is reset. For this reset to function properly, the hardware API controller should already be bootstrapped onto the FPGA and ready to run. For more information, regarding setting up the FPGA to automatically load the hardware API, see the “Programming FPGA &amp; Execution of Example” section. If no errors are present after the function returns (check with the getLast&gt;Error function), this means that the system is capable of communicating with the FPGA and ready for further commands.</td>
</tr>
<tr>
<td><strong>destructor</strong>&lt;br&gt;<code>~ETH_FPGA()</code></td>
<td>Destructor for the API class. Similar to the constructor, this only tears down the software side of the system. Any user or configuration data left on the FPGA is not deleted.</td>
</tr>
<tr>
<td><code>int8_t getLastError()</code></td>
<td>If any of the commands below return false, the cause of the error can be checked with this function. A return of exactly zero indicates no error and any value less than zero indicates an error (see eth_FPGA.h for a list of errors). Although the constructor does not return a boolean value, the user should call this function after the creation of an ETH_FPGA object to make sure that the communication channel initialized successfully.</td>
</tr>
<tr>
<td><code>BOOL sendWrite( uint32_t startAddress, uint32_t length, uint8_t *buffer)</code></td>
<td>Send a block of data from the PC (pointed to by <code>buffer</code> and of length <code>length</code>) to an input buffer on the FPGA. The write will begin at a particular local byte address in the FPGA’s input buffer (startAddress). Returns true if the write succeeds, else return false. Please note that “buffer” is a byte array. Thus, the endian-ness of any multi-byte data types used on the host machine need to be considered when copying values to the buffer. This may change if the user moves from a little endian machine to a big endian machine or vice versa.</td>
</tr>
<tr>
<td><code>BOOL sendRead( uint32_t startAddress, uint32_t length, uint8_t *buffer)</code></td>
<td>Retrieve a block of data (starting at the local address startAddress and of length <code>length</code>) from the output buffer on the FPGA. Place the data into a buffer on the PC (buffer). Returns true if the retrieval succeeds, else return false. Similar to sendWrite, the endian-ness of multi-byte data types on the host machine need to be considered when copying values out of the buffer.</td>
</tr>
<tr>
<td><code>BOOL sendParamRegisterWrite( uint8_t regNumber, uint32_t value)</code></td>
<td>Write a 32-bit unsigned integer (value) into one of the registers (address # regNumber between 0 and 254) within the parameter register file of the FPGA. Returns true if the write succeeds, else return false. Since the datatype...</td>
</tr>
</tbody>
</table>
of value is known, the system compensates for any change in endian-ness on the host machine.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL sendParamRegisterRead( uint8_t regNumber, uint32_t *value)</td>
<td>Read the value of one of the registers (address # regNumber between 0 and 254) within the parameter register file of the FPGA. Put the read value into value. Returns true if the read succeeds, else return false. Similar to sendParamRegisterWrite, this function compensates for changes in endian-ness on the host machine.</td>
</tr>
<tr>
<td>BOOL sendRun()</td>
<td>Start execution on the FPGA by setting the signal userRunValue true. Returns true if the start command is accepted, else return false.</td>
</tr>
<tr>
<td>BOOL waitDone( uint8_t maxWaitTime)</td>
<td>Wait up to maxWaitTime seconds for execution on the FPGA to complete. Returns true if execution completes, else return false. Completion is indicated by the user circuit resetting the userRunValue via the userRunClear line. Further details regarding the hardware API are provided in the next section.</td>
</tr>
<tr>
<td>BOOL sendReset()</td>
<td>Abort execution of the user circuit and return control of the I/O buffers and parameter registers to the API controller by asserting the userSideReset line. While this also resets userRunValue, it does not change anything else on the FPGA (for example, the contents of I/O buffers and parameter registers are unchanged aside from any values that the user circuit might have modified while the userRunValue was true). Returns true if the reset command completes, else returns false.</td>
</tr>
<tr>
<td>BOOL sendWriteAndRun( uint32_t startAddress, uint32_t inLength, uint8_t *inData, uint8_t maxWaitTime, uint8_t *outData, uint32_t maxOutLength, uint32_t *outputLength)</td>
<td>Essentially a combination of the sendWrite, sendRun, waitDone and sendRead commands. Potentially harder to use than separate commands, but also likely much faster. Send a block of data from the PC (pointed to by inData of length inLength) to the input buffer of the FPGA (starting at startAddress). When the data has been sent to the FPGA, start execution and wait up to maxWaitTime seconds for execution to complete. When it is done, read up to maxOutLength bytes of results back from the output buffer, beginning at address 0. Put the results retrieved from the FPGA's output buffer into outData. The hardware-side API monitors writes made to the output buffer by the user's circuit during the execution phase of this command. The highest address written to the output buffer during a given execution cycle is used to determine how many bytes should be read back from the device. The number of bytes read back will be placed in outputLength. Returns true if the entire process succeeds, else returns false. If the function fails with a FAILCAPACITY error, the only problem was that the outData buffer was too small to copy all of the generated results from the FPGA back to the host. If this occurs, the outputLength variable will not contain the number of bytes returned, but rather the total number of bytes the execution phase wanted to return (the number of bytes actually returned will be maxOutLength). The user can then simply read the “overflow” bytes from addresses {maxOutLength, outputLength-1} manually with a subsequent sendRead command. If the function fails with a FAILREADACK error, the device failed to fully respond during the readback phase of the command, despite retry attempts. The outputLength variable will not contain the number of bytes returned, but rather the number of bytes the execution phase wanted to return. The state of outData is unknown, but at least some output data has been partially written. In theory the user could elect to read the entire buffer from {0, outputLength-1} again with a separate sendRead command (despite the fact retries were already made and there is probably some other issue in the system). This option may be attractive if calling sendWriteAndRun is not easy.</td>
</tr>
</tbody>
</table>
For example, if `inData` and `outData` point to an overlapping region, it may be simpler to try and re-read `outData` rather than recreating `inData` so that execution can be attempted again.

```c
BOOL sendConfiguration(
    char *path)

Configure the FPGA using iMPACT and a programming cable from the bitstream file at `path`. Return true if reconfiguration succeeded, else return false. Before using this option, please make certain to properly define the following constants in `eth_FPGA.h`:

- IMPACT
- PATHTOIMPACT
- PATHTOIMPACTTEMPLATEBATCHFILE
- PATHTOIMPACTPROGRAMMINGBATCHFILE
- PATHTOIMPACTPROGRAMMINGOUTPUTFILE
- IMPACTSUCCESSPHRASE

Also, ensure that the batch command template file (PATHTOIMPACTTEMPLATEBATCHFILE) is appropriate for your setup. The included template file has been tested with the `Platform Cable USB II device` and the XUPV5/ML505/ML507 boards. See the “Programming FPGA & Execution of Example” section for more information.

Future versions of this function will provide direct configuration over the Ethernet connection. This will eliminate the need for the host PC to have iMPACT and a programming cable installed. Furthermore, this will make reconfiguration much faster.

---

As will be discussed in more detail in the “Hardware Interface” section, the connections of the Verilog hardware API contain a little-endian bus structure. For example, a 4-byte bus would be indicated with `connection [31:0]`. In this case, the most significant byte would be held in `connection [31:24]` and the most significant bit of that byte be held in `connection [31]`. To maintain code portability with all host PCs, the software-side API will try to conserve the bit and byte ordering used on the host PC and adjust if possible. For example, when `sendParamRegisterWrite` is called on a big-endian byte-ordered PC, the software API will convert the big-endian integer parameter to little-endian byte ordering before transmission to the FPGA. Similarly, `sendParamRegisterRead` will convert the little-endian integer response to a big-endian byte-ordered integer upon receipt. However, no such endian conversion is performed for the `sendWrite` and `sendRead` functions, as the `buffer` parameter is a pure byte-wise array.

4. Hardware Interface

As seen in Figure 1, the user’s circuit on the FPGA primarily interacts with the host PC through three memories: an input buffer, an output buffer, and a set of parameter registers. In the current implementation, these memories are implemented with onboard BlockRAM and the size of the input and output buffers are customizable. The customization process is described in more detail in the “Compiling Hardware” section.

Since the system operates in a master/slave style mode, a user interface signal, `userRunValue` also signifies which device has read/write access to the User device interface. The following specifies the behavior:

- Logic 0 – the host has R/W control of all API logic state. All user logic writes will be ignored and all reads will return zero values.
- Logic 1 – the user logic has R/W control of Input/Output BlockRam and Parameter Register file. No host changes are possible. The user logic relinquishes control by clearing the `userRunValue` (user logic asserts `userRunClear`). Control can be returned to the host (in the event of a problem with the user logic) by calling the `sendReset` function.
Notes:

1) Input Buffer is used by the sendWrite function e.g. data is moving from the PC to the FPGA
2) Output Buffer is used by the sendRead function e.g. data is moving from the FPGA to the PC.

Although the API controller itself requires a small handful of very specific clocks to communicate correctly with the board-level devices, the clock frequency of the interface between the API controller and the user’s logic (userInterfaceClk) can operate at any frequency - arbitrarily low or high, subject to the compilation tools still being able to place and route within the proper timing constraints. The system has been successfully tested with userInterfaceClock set from 7 to 333 MHz, depending upon the target FPGA, desired size of I/O buffers and complexity of user logic. The default setting in the example code is 167 MHz.

The following table provides more specific details for the interface signals that the user’s logic module should take as inputs and should provide as outputs.

<table>
<thead>
<tr>
<th>userInterfaceClk</th>
<th>input</th>
<th>Clock to which all interface signals are aligned. Will function at any frequency (subject to ISE being able to meet timing constraints). User circuit can also use other</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>userLogicReset</td>
<td>input</td>
<td>User circuit should reset when this signal is asserted. Then this signal goes true, the hardware API will reset userRunValue automatically, reclaiming control over the I/O buffers and register file.</td>
</tr>
<tr>
<td>userRunValue</td>
<td>input</td>
<td>User circuit should begin execution when this signal is asserted. The hardware API gives control over the I/O buffers and parameter registers to the user circuit while this signal is asserted.</td>
</tr>
<tr>
<td>userRunClear</td>
<td>output</td>
<td>Asserting this signal will reset userRunValue. This indicates that the user circuit has completed computation and wants to give control over the I/O buffers and parameter registers back to the hardware API.</td>
</tr>
<tr>
<td>register32CmdReq</td>
<td>output</td>
<td>Asserting this line indicates that the user circuit would like to perform a read or write to the register file (depends upon register32WriteEn). The command is accepted by API controller when both register32CmdReq and register32CmdAck are true for 1 clock cycle.</td>
</tr>
<tr>
<td>register32CmdAck</td>
<td>input</td>
<td>This line is asserted when the API controller has accepted the read or write request.</td>
</tr>
<tr>
<td>register32WriteData</td>
<td>output[31:0]</td>
<td>Data to write to the parameter register file.</td>
</tr>
<tr>
<td>register32Address</td>
<td>output[7:0]</td>
<td>Address line to parameter register file.</td>
</tr>
<tr>
<td>register32WriteEn</td>
<td>output</td>
<td>Write enable to parameter register file.</td>
</tr>
<tr>
<td>register32ReadDataValid</td>
<td>input</td>
<td>This line is asserted when the register file has returned with data from a read request. The data will only be valid while this line is true.</td>
</tr>
<tr>
<td>register32ReadData</td>
<td>input[31:0]</td>
<td>Data read back from parameter register file. Will only be valid while register32ReadDataValid is true.</td>
</tr>
<tr>
<td>inputMemoryReadReq</td>
<td>output</td>
<td>Asserting this line indicates that the user circuit would like to perform a read from the input memory buffer. The read command is accepted by API controller when both inputMemoryReadReq and inputMemoryReadAck are true for 1 clock cycle.</td>
</tr>
<tr>
<td>inputMemoryReadAck</td>
<td>input</td>
<td>This line is asserted when the API controller has accepted a read request.</td>
</tr>
<tr>
<td>inputMemoryReadAdd</td>
<td>output[N:0]</td>
<td>Address of read request. Parameterized, more detail in the “Compiling Hardware” section</td>
</tr>
<tr>
<td>inputMemoryReadDataValid</td>
<td>input</td>
<td>This line is asserted when the input memory buffer has returned with data from a read request. The data will only be valid while this line is true.</td>
</tr>
<tr>
<td>inputMemoryReadData</td>
<td>input[M:0]</td>
<td>Data read back from the input memory buffer. Will only be valid while inputMemoryReadDataValid is true. Parameterized, more detail in the “Compiling Hardware” section</td>
</tr>
<tr>
<td>outputMemoryWriteReq</td>
<td>output</td>
<td>Asserting this line indicates that the user circuit would like to perform a write to the output memory buffer. The write command has only accepted by API controller when both outputMemoryWriteReq and outputMemoryWriteAck have been true for 1 clock cycle.</td>
</tr>
</tbody>
</table>
| outputMemoryWriteAck | input | This line is asserted when the API controller has accepted
Figure 2 describes the request/acknowledge logic of the user interface in more detail. In the top diagram of Figure 2, the user circuit would like to submit a read request (asserting `inputMemoryReadReq`). The user circuit must make the read address (`inputMemoryReadAdd`) valid the same cycle that the request line is asserted. If the acknowledge line (`inputMemoryReadAck`) is low, the request has not been accepted by the controller logic until both the request and acknowledge signals have been asserted for 1 clock cycle. Before this occurs, the user logic may lower the request line to cancel the request before it is accepted. After the read request is accepted, the controller will return with the read data (`inputMemoryReadDataValid` is asserted and the data is presented on `inputMemoryReadData`). As seen in the middle diagram of Figure 2, the acknowledge line may already be asserted before the user logic submits a request. In this case, the read request will be accepted the same cycle that `inputMemoryReadReq` is asserted. Extending this concept, as seen in the bottom diagram of Figure 2 multiple reads may be submitted in consecutive cycles if conditions allow – again, a request is accepted any cycle that both `inputMemoryReadReq` and `inputMemoryReadAck` are asserted.

The parameter registers and output memory follows a similar request/acknowledge scheme. In the case of a write, the address, data (and, in the case of the output memory byte mask) signals must begin to be valid the same cycle that the request line is asserted.

<table>
<thead>
<tr>
<th>Output Memory Write Address</th>
<th>Output Memory Write Data</th>
<th>Output Memory Write Byte Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>outputMemoryWriteAdd</code></td>
<td><code>outputMemoryWriteData</code></td>
<td><code>outputMemoryWriteByteMask</code></td>
</tr>
<tr>
<td><code>output[N'.0]</code></td>
<td><code>output[M'.0]</code></td>
<td><code>output[log2(M'/8):0]</code></td>
</tr>
<tr>
<td>Address of write request. Parameterized, more detail in the “Compiling Hardware” section</td>
<td>Data of write request. Parameterized, more detail in the “Compiling Hardware” section</td>
<td>Byte-wise write enable of write request. Parameterized, more detail in the “Compiling Hardware” section</td>
</tr>
</tbody>
</table>
5. Compiling Hardware

The existing codebase should work with any “transceiver” Virtex 5 (LXT, SXT, TXT, FXT but not the baseline LX series). It was developed using ISE 10.1, but has been tested extensively with ISE through version 11.5. Compatibility through ISE 12.1 has not yet been verified, but as we have not encountered any serious issues to date, we do not expect any issues with newer versions of the tools. All sample screenshots depict ISE 10.1 and CORE Generator version 10.1. The user interface for new versions of the tool have changed slightly, but all of the same options should be available.

1) Create a new project in Xilinx Project Navigator
   a. Begin a new project from “File->New Project”. Enter a name and location for the project, making sure to select “HDL” as the top-level source.
b. Select the appropriate device, package and speed for your platform. Below are the parameters for the boards we directly support. If you port this system to any other platforms, please let me know.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Device</th>
<th>Package</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>ML505</td>
<td>XC5VLX50T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ML506</td>
<td>XC5VSX50T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ML507</td>
<td>XC5VFX70T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>XUPV5</td>
<td>XC5VLX110T</td>
<td>FF1136</td>
<td>-1</td>
</tr>
<tr>
<td></td>
<td>XC5VLSX95T</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BEE3</td>
<td>XC5VLX110T</td>
<td>FF1136</td>
<td>-2</td>
</tr>
<tr>
<td></td>
<td>XC5VLSX95T</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

C. Ensure that “Verilog” is at least part of the parameter selected for the remaining project options and click “Next”.

D. We will be adding existing sources later, so click “Next” until prompted to “Finish”.

- 10 -
II) Add all of the appropriate source files to your project.

   a. Right-click in the “Sources” window and select “Add Source...” and browse to the HWSrc directory (if installed to the default location, it will be in

   C:\Program Files\Microsoft Research\Simple Interface for Reconfigurable Computing (SIRC)\HWSrc

   or

   C:\Program Files (x86)\Microsoft Research\Simple Interface for Reconfigurable Computing (SIRC)\HWSrc

   b. Add all of the .v files in the appropriate platform directory and one .ucf file for your platform (e.g. XUPV5system.ucf if targeting the Virtex 5 XUP board, ML505system.ucf if targeting the ML505, etc.).

   c. Click “OK” to add all of the files to the project.
d. Double-check in the “Sources->Sources” window to ensure that the system module is the top-level module. This is indicated by a green icon to the left of the system module. If this module is not the top-level module, make it the top-level module by right-clicking the system module and selecting “Set as Top Module”.

This project also relies on a few free cores generated by CORE Generator. We cannot re-distribute Xilinx's IP, so the user must generate those cores themselves. Below are instructions that describe how to generate the proper cores. Although some of the older versions of the CORE Generator modules are no longer available with newer versions of the tool, this does not seem to be an issue. Most of the differences in the CORE Generator versions are indicated below.

III) EMAC Wrapper

a. Start CORE Generator from “Start->Programs->XILINX_DIRECTORY->Accessories->CORE Generator”. CORE Generator can be started from within Project Navigator, but we have had problems with code generated when CORE Generator is started in this way.
b. Create a new project within the ISE project directory created in step 1.

i. Select the proper part for your board (for example, the ML505 boards use a Virtex5 xc5vlx50t-ff1136-1 part).

ii. Switch to the "Generation" Tab and change "Design Entry" to Verilog.
iii. The default options should be acceptable for other options.

c. Select "Communications & Networking→Ethernet→Virtex5 Embedded Tri-mode Ethernet MAC Wrapper", version 1.5.

i. If only later versions of the core are shown (this was the latest version as of CORE Generator 10.1.03), select "Show→All Versions" in the main window. Newer versions of the core may work, but Xilinx changes the interfaces that they use from time to time. Thus, it is safest to use version 1.5 if possible. Version 1.5 is available with ISE 11.4, although there is also a newer version 1.6 offered. We have not tested this system with version 1.6.

d. Select “Customize”
i. Name – The existing codebase is expecting the module to be named "v5_emac_single".

ii. Select only one EMAC. I have tested with EMAC0, but EMAC1 should work as well.

iii. As of CORE Generator 10.1.03, the rest of the settings should remain at their default values. The critical values to double-check are on Page 2 – Physical Interface: GMII and Speed: 1000 Mbps.
e. Select “Finish” or “Generate” and CORE Generator will create the core’s logic. A new “v5_emac_single” directory will be created within the root project directory or within a “cores” directory.

f. Add the following 7 files from the newly generated core to the ISE project. This can done by right-clicking in the “Sources” window and selecting “Add Source…”

i. `v5_emac_single\example_design\client\fifo\eth_fifo_8.v`

ii. `v5_emac_single\example_design\client\fifo\rx_client_fifo_8.v`

iii. `v5_emac_single\example_design\client\fifo\tx_client_fifo_8.v`

iv. `v5_emac_single\example_design\physical\gmii_if.v`

v. `v5_emac_single\example_design\v5_emac_single.v`

vi. `v5_emac_single\example_design\v5_emac_block.v`

vii. `v5_emac_single\example_design\v5_emac_locallink.v`

g. Double-check that the system/E2M/v5_emac_ll module (and the modules used inside of this module) have been recognized by ISE. When browsing the design in the “Sources” window, there should no longer be a question mark inside the system/E2M/v5_emac_ll module document icon (nor a question mark inside the icons of system/E2M/v5_emac_ll/v5_emac_block, system/E2M/v5_emac_ll/v5_emac_block/gmii0, etc.).
IV) Input/Output buffers and Parameter Register File

h. Using the same CORE Generator project as the EMAC wrapper, generate the logic for the parameter register file. Under the “View by Function” tab, select “Memory & Storage Elements ➔ RAMs & ROMs ➔ Block Memory Generator”, version 2.8. ISE 11.5 does not offer this version of the block memory generator, but the newer version 3.3 works with our system.

i. Select “Customize”

i. Generate core with the settings:
1. Name: “blk_mem_gen_paramReg” and Memory Type: True Dual Port RAM

2. Port A Options
   a. Memory Size Write Width: 32
   b. Memory Size Write Depth: 255
   c. Memory Size Read Width: 32
   d. Operating Mode: Write First
   e. Enable: Always Enabled
3. Same values for the Port B options
   
a. Memory Size Write Width: 32
b. Memory Size Write Depth: 255
c. Memory Size Read Width: 32
d. Operating Mode: Write First
e. Enable: Always Enabled
4. No registering for either port (double-check that none of the “Optional Output Registers” boxes are selected)

j. Select “Finish” or “Generate” and CORE Generator will create the core’s logic. A new “blk_mem_gen_paramReg.xco” file will be generated within the root project directory or within a “cores” directory.
k. With the same method as used for the Ethernet source files, add the “blk_mem_gen_paramReg.xco” file to the ISE project and double-check that the system/E2M/ethernetController/blk_mem_gen_paramReg module has been recognized by ISE. Notice that the icon will not turn into a small document with a “V”, but rather into a small CORE Generator lightbulb.

![Image of CORE Generator lightbulb]

l. Repeat the process to generate another block memory with the setting:

   i. Name: “blk_mem_gen_inputMem” and Memory Type: Simple Dual Port RAM (Notice, this is not a True Dual Port RAM as with the parameter register file)
ii. Port A Options

1. Memory Size Write Width: 8
2. Memory Size Write Depth: *As per the user’s requirements* (discussed in section v below).
3. Enable: Always Enabled

iii. Port B Options

1. Memory Size Read Width: *As per the user’s requirements* (discussed in section v below)
2. Enable: Always Enabled
iv. Output Registers

1. No registers on Port A

2. Register Port B Output of Memory Core: As per the user’s requirements (discussed in section vi below)
v. Regarding user customization, the default parameters at the top of the "system.v" file define a $2^{17} = 131,072 \text{ KB}$ memory (INMEM_USER_ADDRESS_WIDTH = 17) with a user-side interface of 1 byte wide (INMEM_USER_BYTE_WIDTH = 1). The depth for both ports and the port B read width (as powers of 2 number of bytes) can be changed to fit the user's needs. For example, if we wanted to create a larger 512KB buffer with a user side interface of 32-bits wide, we would update the .xco in CORE Generator by:

1. Leaving the port A write width at 8
2. Changing the port A write depth to 524,288 (step ii.2 above)
3. Changing the port B read width to 32 (step iii.3 above, which automatically updates the port B read depth to 131,072)
4. Changing two parameters in the "system.v" file - INMEM_USER_BYTE_WIDTH = 4 and INMEM_USER_ADDRESS_WIDTH = 17

Any time that the user wishes to change the size or arrangement of the input memory, the appropriate parameters in the "system.v" file should be updated and CORE Generator should be re-run on the blk_mem_gen_inputMem module with the appropriate arguments.

One note, if the user-side interface is larger than 1 byte wide, the inputMemoryReadData line will be organized as little endian. For example, if the interface is 32-bits wide,

$$\text{inputMemoryReadData}[31:0] = \{\text{byte3}, \text{byte2}, \text{byte1}, \text{byte0}\}$$

vi. As for registering the port B output, this may be necessary to meet the desired timing if the input memory itself is large or if fanout of the input memory to the user’s circuit is large. Register this output increases the read latency of the memory 1 or 2 clock cycles (although any changes in the latency should not require changes to the user’s circuit due to the request/acknowledgement handshaking on the interface). The user may elect to select "Register Port B Output of Memory Primitives", "Register Port B Output of Memory Core" or both. If the core is generated with port B registering on, set the INMEM_USER_REGISTER parameter in the "system.v" file to 1 or 2. CORE Generator indicates the “Latency added by output register(s):” on page 4 of the customization process. The value reported should be used for the INMEM_USER_REGISTER parameter. The default setting at the top of the “system.v” file is 1.

m. Select “Finish” or “Generate” and CORE Generator will create the core’s logic. As before, a new “blk_mem_gen_inputMem.xco” file will be generated. Add the .xco file to the ISE project and double-check that the blk_mem_gen_inputMem module has been recognized by ISE.

n. Generate one last block memory with the settings:

i. Name: “blk_mem_gen_outputMem”, Memory Type: Simple Dual Port RAM, and

ii. Write Enable: Use Byte Write Enable, Byte Size 8 bits

iii. Port A Options

1. Memory Size Write Width: As per the user's requirements (discussed below in section vi)
2. Memory Size Write Depth: As per the user’s requirements (discussed below in section vi).

3. Enable: Always Enabled

iv. Port B Options

1. Memory Size Read Width: 8
2. Enable: Always Enabled

v. Output Registers

1. No registering on either port A or port B

vi. Regarding user customization, the default parameters at the top of the “system.v” file define a $2^{13} = 8192 = 8$KB memory (OUTMEM_USER_ADDRESS_WIDTH) with a user-side interface of 1 byte wide (OUTMEM_USER_BYTE_WIDTH). The depth for both ports and the port A write width (as powers of 2) can be changed to fit the user’s needs. The OUTMEM_USER_ADDRESS_WIDTH and OUTMEM_USER_BYTE_WIDTH parameters can be modified in a similar manner as the input memory values. As with the input memory, any time that the user wishes to change the size or arrangement of the input memory the appropriate parameters in the “system.v” file should be updated and CORE Generator should be re-run.

o. Select “Finish” or “Generate” and CORE Generator will create the core’s logic. Again, a new “blk_mem_gen_outputMem.xco” file will be generated. Add the .xco file to the ISE project and double-check that the blk_mem_gen_outputMem module has been recognized by ISE.

At this point, the user should be ready to compile the example circuit. This can be done by selecting the “system” module in the “Sources” window and double-clicking “Generate Programming File” in the “Processes” window.
When the compilation is complete, it will create a new “system.bit” file in the root project directory. The functionality of this new bitfile will be tested in the following “Programming FPGA & Execution of Example” section.

One note regarding MAC addresses. The user should customize is the MAC address of the FPGA (MAC_ADDRESS in system.v) so as to avoid duplicate MAC addresses on the same subnet. Furthermore, the user should also try to avoid broadcast or multi-cast MAC addresses (unless that is what the user truly desires). If this parameter is updated, the Ethernet Wrapper does not need to be regenerated through CORE Generator. However, the circuit does need to be recompiled in ISE.

6. Programming FPGA & Execution of Example

Programming FPGA

Once the user has a valid bitstream, either generated from scratch using the instructions in Section 5 or from the “precompiledExampleBinaries” directory (double-checking to ensure that they select the correct bitstream file), they can use it to program their FPGA. There are three preferred ways to program the FPGA:

1) Using iMPACT through the GUI (in “Start→Programs→XILINX_DIRECTORY→Accessories→iMPACT)
2) Using iMPACT through the SIRC sendConfiguration command
3) Programming at power-on from on-board flash memory

Methods #1 and #3 are important because it is generally assumed that the FPGA will already be connected to the host PC and programmed with a circuit that has the SIRC hardware API before the constructor for the SIRC software API is called. For example, the ETH_SIRC constructor calls the sendReset function just before it returns. This validates that the software can communicate with the hardware API within the constructor. If a circuit with the SIRC hardware API is not already programmed onto the FPGA, the constructor will return with a “fatal” error code (in this particular case, FAILINITIALCONTACT = -7). The user may elect to ignore this error code and call a subsequent sendConfiguration command, but we discourage this type of use.

The simplest way to insure that the FPGA is always capable of being used with the SIRC API is to bootstrap at power-on from on-board flash memory. While the exact technique to do this can differ slightly from development board to development board and from flash technology to flash technology, performing this on the ML505/ML507 or Digilent XUPV5 boards is quite straightforward. Documentation regarding how to do this is can be found in the “ML505/ML507 Getting Started Tutorial” available for download at the Xilinx website.

The sendConfiguration command requires a few compile-time constants to be defined before it can be used. As shown in eth_SIRC.h, six constants are needed:

<table>
<thead>
<tr>
<th>IMPACT</th>
<th>Declares intention to use the sendConfiguration command with iMPACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>PATHTOIMPACT</td>
<td>Path to iMPACT executable</td>
</tr>
<tr>
<td>PATHTOIMPACTTEMPLATEBATCHFILE</td>
<td>Path to a template IMPACT batch file. An example template file (impactMatchTemplate.cmd) is provided in the “precompiledExampleBinaries” directory. The only difference from the standard batch commands described in the iMPACT documentation (provided with the iMPACT GUI program “Help→Help Topics→Software Help→iMPACT Help→Command Line and Batch Mode”) is the inclusion of the “BITSTREAMFILENAME” keyword. This keyword replaces the bitstream filename that would normally be used with the assignFile</td>
</tr>
</tbody>
</table>
command.

| PATHTOIMPACTPROGRAMMINGBATCHFILE | Path to which software API can write a temporary file. This will be the command batch file passed to iMPACT during execution of the `sendConfiguration` function. If iMPACT cannot successfully program the device, try to run this file from the command line with “iMPACT-batch filename.cmd” |
| PATHTOIMPACTPROGRAMMINGOUTPUTFILE | Path to which software API can redirect iMPACT output during programming. This file will be parsed by the software API to determine success or failure of programming attempt. This file can also be examined by the user if iMPACT is unable to successfully program the FPGA. |
| IMPACTSUCCESSPHRASE | When iMPACT successfully programs the FPGA, what is the reply? If unsure, the user can examine the file that is produced at PATHTOIMPACTPROGRAMMINGOUTPUTFILE. |

**Executing Example**

The user can either compile the example software or use the pre-compiled executable in the “precompiledExampleBinaries” directory. The software binary should be run from a command line. For the default settings of the hardware example (also compiled into the provided FPGA bitstreams), no arguments are required. Any errors that are encountered will be reported back to the user and can be looked up in the `eth_SIRC.h` file. View the example software source code for more details.

The XUPV5/ML505/ML506/ML507 boards have a few configuration jumpers that need to be set to ensure correct operation. First, the default UCF file indicates some 2.5V I/O. J20 (on the top right of the board near the power switch) should have both jumpers between pins 2 & 3 (to the right side) to select 2.5V I/O on two of the FPGA's pin banks (as set in the provided "system.ucf" file). Second, the current implementation uses a GMII interface to the PHY. J22 & J23 (bottom left near the DVI output) should have both jumpers between pins 1 & 2 (to the left side). Third, if you are trying to configure the FPGA with a Platform Cable JTAG programmer, you don't have to worry about the DIP switch settings of SW3 (upper left near the keyboard port). However, if you are trying to bring the configuration from the Compact Flash or other on-board Flash memory, pay attention to the settings of SW3. The "ML505/ML506/ML507 Evaluation Platform" document from the Xilinx website can help you figure out what is appropriate for your situation. Look at item #31 - "Configuration Address and Mode DIP Switches". Personally, I like to bootstrap the board from configuration #0 on the CF. This requires a setting of "00010101" reading from DIP 1 to DIP 8 left to right. See the "System ACE CompactFlash Solution" document from the Xilinx website for more information.

The BEE3 does not need any configuration jumpers to be set.